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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2009 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Intel® and Pentium® are registered trademarks of Intel Corporation in the U.S. and other countries. 

This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 

 

For additional licensing information about third party and open source software, see the 
open_source_and_third_party_licenses.pdf file in the bin\documentation folder on the DDM 
Inventory 7.51 distribution media. 
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html

 3 



HP Discovery and Dependency Mapping 
Inventory 

Release Notes 
Software version: 7.51 / March 2009 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 
(DDM Inventory) for version 7.51. It contains important information not included in the manuals or in the 
online help. 

Conventions Used in this Document  

In This Version

New Features

Compatibility Notes

Agent and Scanner Support Information

Obsolete Features

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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Conventions Used in this Document  
By default, when you install the DDM Inventory server software, all the components will be in one of the 
locations specified in the following table. The placeholders are used to represent the DDM Inventory 
program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Windows  
Server 2008 
x64 

C:\Program Files (x86)\Hewlett-
Packard\DDMI\7.51

Program 
Files 

<InstallDir> 

All others C:\Program Files\Hewlett-Packard\DDMI\7.51

Windows  
Server 2008 

C:\ProgramData\Hewlett-Packard\DDMIData Files <DataDir> 

Windows 
Server 2003 

C:\Documents and Settings\All Users\ 
Application Data\Hewlett-Packard\DDMI

You can customize both of these locations when you install the DDM Inventory server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 7.51. This version of the product is the upgrade path for users of 
DDM Inventory 7.50 and Enterprise Discovery 2.5x and 2.2x.  

To see what features have been introduced in previous versions of DDM Inventory (formerly called 
Enterprise Discovery), refer to the Release Notes for the versions noted above. These are available on your 
installation CD under bin\documentation.  

Number of Devices 

Each DDM Inventory server can collect data from a maximum of 50,000 inventoried devices and 60,000 
discovered devices in total. The port limit is 150,000 ports (whichever comes first). A DDM Inventory 
Aggregator can support 50 servers and up to 500,000 devices. 

Updated Third-Party Components 

• MySQL 5.0.72 

• OpenSSL 0.9.8i 

• OpenSSL 0.9.7m 

• Apache HTTP Server 2.2.10 

• JRE 1.5.0_17 
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New Features  

Managing Devices with Dynamically Assigned IP Addresses 

By default, DDM Inventory will no longer deactivate devices with duplicate main IP addresses in its 
database. Instead, DDM Inventory will remove the main IP address from the older device record and will 
unschedule all modeling and scanning requests to run on the older device until the device’s new IP address 
is discovered.  

The default setting ensures that DDM Inventory will not deactivate devices in its database that have had 
their IP addresses reassigned to a different device. This is useful if many users connect their devices to the 
network infrequently and for short periods of time. In such cases, IP addresses are reused and assigned to 
other devices.  

You can configure DDM Inventory to deactivate a device in its database if it discovers another device with 
the same IP address. The configuration option is located at Administration > System Configuration > 
Network devices > Deactivate older devices with duplicate IP addresses. This option defaults to YES on 
upgrade and to NO on a new install. 

For more details about this feature, refer to the “Adding, Removing, and Replacing Devices” chapter in the 
Configuration and Customization Guide. 

Support for Windows 2008 Server x64 

The DDM Inventory 7.51 Server can be installed on the 64-bit version of Windows 2008 Server. Refer to the 
Compatibility Matrix for information about all supported platforms. 

Scanner Enhancements 

• The number of physical CPUs, logical CPUs, and CPU cores are now correctly reported on HP-UX for 
both HPPA and HP Itanium platforms.  

• 19 new Intel, AMD, and VIA Technologies CPUs are now detected by the scanner hardware detection 
logic  
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Compatibility Notes  

Aggregate Database Change 

The File_ApplicationName column in the File table of the Aggregate database is now obsolete. You 
must use the data in the File_Description column instead. 

 

 

Agent and Scanner Support Information  
Scanner and agent support for the following platforms was removed as of release 7.50: 

Platform Last Release Providing Support 

IBM AIX 5L 5.0 and 5.1 Enterprise Discovery 2.52 

All other scanners and agents supported in the 2.5x releases and the 7.50 release of this product are 
supported in the 7.51 release. Refer to the Compatibility Matrix for the 2.5x release of interest for the list of 
all supported platforms. 
 

 
It is possible to use the scanners and agents from previous releases if you explicitly specify the 
scanner and agent versions using the configuration options on the following pages: 
Administration > System Configuration > Scanner deployment

Administration > System Configuration > Agent communication
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Obsolete Features  
All features in 7.50 are supported in release 7.51. See Compatibility Notes. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals/

1 Clear the Show only my products box. 

2 In the Product list, click the product name (for example, DDM Inventory). 

3 In the Version list, click the version number. 

4 In the OS list, click the operating system type. 

5 Click Search. A document list is displayed that matches your search criteria. 

6 In the document list, click the document title. The document opens in your browser window. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the DDM Inventory user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 

 

The Configuration and Customization Guide has been reissued for this release to document the new way 
DDM Inventory manages devices with dynamically assigned IP addresses. See New Features.
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Installation Notes 
Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 
provided in Adobe Acrobat (.pdf) format.  

 Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 
server installation. If you have these components installed already, make sure to remove them 
before installing DDM Inventory. You may NOT substitute any other technologies in place of the 
standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 
respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor, SAI Update Wizard, System 
Panel, and Viewer) have the following minimum requirements: 

Resource Requirement 

Operating System Windows 2000, XP, 2003, 2008 or Vista 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 
versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2, or R2) or 
Windows Server 2008 (SP1) or the 64-bit version of Windows Server 2008. Refer to the Compatibility Matrix 
for information about all supported platforms. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

• HP Proliant Model: DL380 G5 (Performance)  

• CPU: 2 x Quad Core (Intel® Xeon® 5400 series)  

• Memory: 8 GB 

• Disk: See the Software and Hardware Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

• HP Proliant Model:  DL360 G5 (Performance) 
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• CPU: 1 x Quad Core(Intel® Xeon® 5400 series) 

• Memory: 6 GB 

• Disk:  See the Software and Hardware Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 
Inventory installation. 

The information presented below is for illustration purposes only. Proper sizing of the DDM Inventory 
server(s) may require the assistance from a qualified architect.  HP recommends utilizing experienced 
resources to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that 
need to be considered and which will impact the infrastructure architecture are the following: 

• Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

• Type of and amount of information collected (examples below demonstrate the impact software 
utilization will have on overall system capacity) 

• Frequency of scans (the example below assumes the scan interval is every two weeks; more frequent 
scanning may require additional server capacity) 

• Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 
representative of an average PC (large servers may generate considerably more data and therefore 
require additional capacity to process the data) 

• Environmental factors, such as integrations with other products, network characteristics, and 
operational requirements may impact the architecture of the DDM Inventory solution 

• The number of XML Enricher instances that are running on the server 

• The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 
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Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Memory 
(GB) CPU* 

Disk 
(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

• CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements 

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 
resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 
server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 
reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 
environment. For a medium to large DDM Inventory server deployment, minimum recommended 
throughput (as benchmarked on an idle system when the DDMI Inventory server is not running) is  
70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 
clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 
Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, it 
gets extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 
keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 
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requirements, we recommend that you budget at least 5 times as much disk space for each device being 
scanned.     

 If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

• Raid 1 

• Raid 1+0 

DDM Inventory has been tested and can be successfully installed in a RAID (redundant array of 
independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy, however it improves performance. If one drive fails then all 
data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate so long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 
tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

If you are upgrading from DDM Inventory 7.50, Enterprise Discovery 2.5x, or Enterprise Discovery 2.2x, 
follow these steps: 

Step Instructions 

1. Back up your discovery data Refer to “Backing Up and Restoring Your 
Data” in the Installation and Initial Setup 
Guide

2. Copy your Analysis Asset Field 
configuration (if necessary – not required 
when upgrading from DDM Inventory 
version 7.50) 

See “Copy Your Analysis Asset Field 
Configuration” below 

3. Uninstall the older version See “Uninstall Older Version” below. 

4. Install DDM Inventory version 7.51 Refer to “Server Installation” or “Client 
Installation” in the Installation and Initial 
Setup Guide

5. Copy User SAI files into new location 
(not required when upgrading from 
DDM Inventory version 7.50) 

See “Copy User SAI Files” below. 
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Copy Your Analysis Asset Field Configuration 

 This section does not apply when you are upgrading from version 7.50. 

The XML Enricher now reads the analysis asset field configuration from the viewer.ini file located in the 
<DataDir>\Conf directory, where <DataDir> is the location of the DDM Inventory data folder that you 
specify at install time. 

If your analysis asset field configuration used for the XML Enricher is already in the viewer.ini file, it 
will be used, and no action is required.  

If this configuration is no longer available, you must manually copy the analysis field section of the 
xmlenricher.ini file to the viewer.ini file before upgrading to DDM Inventory version 7.51. 

Uninstall Older Version  

After you have backed up your discovery data, you must uninstall the DDM Inventory/Enterprise Discovery 
components before installing DDM Inventory version 7.51. 

To remove the older version components installed on your system: 

1 In Control Panel > Add/Remove Programs (for Windows Server 2003) or Control Panel > Programs and 
Features (for Windows Server 2008), select HP Discovery and Dependency Mapping Inventory or HP 
Enterprise Discovery depending on the older release that you have installed. 

2 Click Remove. Follow the on-screen instructions. 

3 Optional: You can also uninstall the discovery Agent if you so choose. This is not necessary, however. 
When the DDM Inventory server starts up, it installs an Agent if and only if the server machine does not 
already have an Agent. 

4 Remove the following folder:  <OldInstallDir>\Tomcat 

In this case, <OldInstallDir> is the installation directory that you specified when you installed DDM 
Inventory or Enterprise Discovery. By default, this was:  

Version 2.2x   C:\Program Files\HP OpenView\Enterprise Discovery\2.2*

Version 2.5x  C:\Program Files\Hewlett-Packard\Enterprise Discovery\2.5* 

Version 7.50  C:\Program Files\Hewlett-Packard\DDMI\7.50  

5 Optional: View the DDM Inventory uninstall log file, which contains a list of all the files and folders that 
were removed during the uninstall: 

<OldInstallDir>\uninstall\uninst_ED.log

6 Restart your server. 

 You must restart your server before installing DDM Inventory version 7.51.  

 If you have the client tools of a previous release installed, you must remove them. DDM 
Inventory does not support multiple versions of the client tools on the same machine—whether it 
is the DDM Inventory server machine or any other system where the client tools are already 
installed. 
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Copy User SAI Files 

 This section does not apply when you are upgrading from version 7.50. 

Beginning with Enterprise Discovery 2.50, all User SAI files are stored in this location: 

<DataDir>\SAI 

where <DataDir> is the data folder that you specify at installation time. 

If you are upgrading from Enterprise Discovery 2.2x or 2.5x, the default <DataDir> is the location of the 
data folder prior to the upgrade. For Enterprise Discovery 2.2x and 2.5x, the default <DataDir> was: 

C:\Documents and Settings\All Users\Application Data\Peregrine\Enterprise Discovery 

SAI files that are configured to be used with the XML Enricher are explicitly specified in the following file: 

<DataDir>\Conf\Xml Enricher.ini 

When you upgrade to DDM Inventory version 7.51, any User SAI files listed in this file are automatically 
copied into the <DataDir>\SAI folder. Any User SAI files that are not listed in this file are not copied. 

You should perform the following steps after you install DDM Inventory version 7.51: 

• Copy any User SAI files that were not automatically copied during the installation into the 
<DataDir>\SAI directory. 

• If you are upgrading from an Enterprise Discovery version 2.2x installation, copy the 
<OldInstallDir>\Common\sai.ini file into the <DataDir>\Conf directory. 

Here, <OldInstallDir> is the destination folder that you specified when you installed Enterprise 
Discovery version 2.2x. The default was: 

C:\Program Files\HP OpenView\Enterprise Discovery\2.2* 

For version 2.5x and 7.50 installations, the sai.ini file is already located in <DataDir>\Conf. 
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Enhancements and Fixes 
The following items were fixed in the current software release (identified by error tracking number). 

Table 2 Enhancements 

Number Location Description 

QC19266 Server After discovery configuration changes have been activated, 
the Server will promptly attempt to schedule the scanner 
deployment workflow on the devices where the workflow had 
previously failed. 

 

Table 3  Problems Fixed 

Number Location Description 

QC18964 Server SUSE platforms no longer require the 
PasswordAuthentication entry in the 
/etc/ssh/sshd_config file to be enabled for agentless 
scanning to work properly. The SUSE default to use 
keyboard-interactive for SSH authentication is now 
supported. 

QC18983 Linux Agent The signal handling warning – SIGCHLD set to SIGNIGN but 
calls wait() – no longer appears in the system log or the 
console when the Linux Agent is running. 

QC19006 Administration > 
System 
Configuration > 
Scan Processing 

The details of the User SAIs with no description were not 
shown. 

QC19012 Mac OS X PPC 
Scanner 

The CPU model on Mac OS X platforms is now displayed 
correctly. 

QC19015 Status > Device 
Status > Agent 
status 

The “Application Usage Manager failed” error message is 
rebranded to refer to the current names for the Usage 
Manager and the product.  

QC19027 Scanners In rare circumstances, the scanner failed when collecting 
inventory information about certain monitors – this has been 
fixed. 

QC19028 Windows Agents DDM Inventory can now uninstall the HP Client Automation 
Application Usage Manager Agent (version 7.2x) after 
migration if so requested. 

QC19033 Server The logging of warning messages in the aggregate event 
import job is now limited to a maximum of 100 entries per 
Event file to avoid flooding the discovery log. 
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Number Location Description 

QC19037 Server Data generated during agentless scanning is now saved in a 
directory private to a specific server. This should prevent 
interference with a local agent or another server performing 
an agentless scan on the same device. 

QC19043 Mac OS X Agent The Mac OS X agent no longer erroneously uses port 2738 
when it is configured to use port 7738. 

QC19047 Server The Agent Communicator no longer experiences delays when 
trying to open a Windows RPC session. 

QC19055 Network Map The Network Map now opens properly when handling multi-
byte character encoded strings in the Device Title or Device 
Tag fields.  

QC19081 Help The Host.Host_OS and Host.Host_OSVersion columns are 
now correctly specified in the schema documentation. 

QC19093 Administration > 
Discovery 
Configuration > 
Schedules 

Administration > 
Discovery 
Configuration > 
Configuration 
Profiles 

The “Associated Profiles” tab under the Schedule detail page 
now correctly displays all profiles associated with a schedule. 

The drop-down lists of schedules under various Configuration 
Profiles now correctly list newly added schedules. 

QC19106 Windows Scanner When the Scanning for Applications/Program Files Scanner 
Generator option is enabled, the scanner now shows this 
option in the log along with other targeted scanning options. 

QC19115 Server The settings for “Location of Scanner Executable for Agentless 
Scanning” under Administration > System Configuration > 
Scanner Deployment are no longer randomly reset during 
Activation. 

QC19117 Server The scanner deployment workflow now automatically 
switches the port used for agent communication when the 
“Agent port” option (under Administration > System 
Configuration > Agent communication) is modified, and the 
Server can no longer contact the Agent using the old port 
value. 

QC19121 Scanners A fatal program error no longer occurs in the Scanners when 
the trace log option is used. 

18 



Number Location Description 

QC19122 Device Manager If the “Accept changed public client key” option is not selected 
in the Agent profile, and the public client key on a scanned 
device with this profile changes, the Server will generate an 
exception. When this happens, the option to reset the recorded 
SSH public key for this device from the Device Manager is 
now enabled. 

QC19125 Server The agentless scanning workflow no longer fails to 
communicate with the managed device if an agent is (or was) 
installed on it. 

QC19133 Reports The information in the Solaris Zones Reports in the Aggregate 
Reports is now reported consistently. 

QC19136 Server Previously, workflow communication occasionally failed with 
a java.net.SocketException: Socket is closed error, even 
though communication with the targeted device could be 
established.  

QC19137 Find Aggregate Find by MAC Address now works properly. 

QC19140 Server Scheduling devices to be rescanned now works correctly when 
the “Automatic workflow interval configuration” option (under 
Administration > Discovery Configuration > Scanner 
Configuration Profile) is set to very short time intervals (for 
example, 1-2 hours). 

QC19142 Status > Device 
Status > Agent 
Status 

The filtered values for Status > Device > Agent > SSH Public 
Key Status no longer all display as n/a. 

QC19152 Server Remote discovery of a VMware ESX server no longer fails 
when there is no host or VM information defined – as is the 
case when a VMware ESX server installation is fresh and has 
no virtual machines defined yet.  

QC19153 Analysis 
Workbench 

SAI Editor 

When multiple User SAIs were loaded, saving changes caused 
the IDs of items to be incremented in some cases. This 
problem may have caused !NOT IN SAI! entries to appear in 
the Analysis Workbench.  

QC19154 Administration > 
Data Management 
> Update device 
models 

Administration > Data Management> Update device models 
is no longer missing the “Run Agentless Scanner” action. 

QC19155 Server Device modeling scheduling has been optimized to allow 
devices with older models to be modeled in priority sequence 
and to use proper modeling intervals to reload the queue for 
device model updates. 
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Number Location Description 

QC19156 Server The Discovery Engine no longer experiences memory 
exhaustion problems, as it can now allocate up to 3GB of 
memory if the Windows server has the /3GB option enabled in 
boot.ini. 

QC19161 Server On UNIX/Linux/Mac machines, the scanner deployment 
workflow now follows the correct sequence for all the 
deployment credential combinations. 

QC19162 Administration > 
Data Management 
> Update device 
models 

Actions related to the agent and scanner workflows are now 
disabled if the corresponding “Automatic agent deployment 
active” and “Automatic scanner deployment active” options 
under Administration > System Configuration > Discovery 
services are turned off. 

QC19166 Server If the file containing the services statistics becomes corrupted, 
it no longer causes the DDM Inventory server to stop 
functioning. 

QC19174 Administration > 
System 
Configuration > 
Scanner 
Deployment 

The “Scanner Versions” configuration options now list the 
7.5x scanner versions in the drop-down list. 

QC19178 Server > 
Administration > 
Discovery 
Configuration > 
Deployment 
Credentials 

When you select multiple deployment credentials and click 
Delete, the action now deletes multiple credentials instead of 
only a subset of the selected items. 

QC19181, 
QC19218, 
QC19440 

Server The XML Enricher no longer hangs when processing some 
corrupt scan files. 

QC19188 Server The Discovery Engine now loads the last used credentials on 
start-up for agentless scanning authentication. 

QC19192 UNIX Scanners The likelihood that a scanner will fail due to a stale NFS 
mount on a UNIX device has been greatly reduced. Note that 
there is still a small chance that the scanner will fail if the 
NFS server is improperly configured.   

QC19194 Server The old SSH public key now gets reset in the database when 
you click Reset in the Device Manager or perform a bulk reset 
on the Administration > Data Management page.  
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Number Location Description 

QC19198 Administration > 
System 
Configuration > 
Agent 
communication  

If the “Allow downgrade agent version” option on the 
Administration > System Configuration > Agent 
communication page is set to Yes, a warning about 
downgrading the agent version is no longer displayed for 
devices where the Agent is not installed. 

QC19199 Device Manager The Device Manager now shows the last scanner deployment 
workflow type used in the diagnostics panel. 

QC19207 Administration > 
System 
Configuration > 
Scan processing 

The custom drop-down list of the “SAI file used to store rule-
created items” configuration option under Administration > 
System Configuration > Scan processing now displays all 
the user SAI files. 

QC19209 Server The XML Enricher health file is no longer locked by the UI 
when the Status > Current Settings > System configuration 
page is displayed. 

QC19210 Server Creating the activation report for the Discovery Configuration 
has been optimized for speed on very busy systems. The UI no 
longer times out when attempting to render the activation 
page. 

QC19214 Server Under certain circumstances, events could not be aggregated 
properly.  

QC19216 Network Map The Network Map now opens correctly when the Package 
Title includes multi-byte Japanese characters. 

QC19217 Server The race condition no longer occurs when importing events 
into the Aggregate database. 

QC19236 Administration > 
Discovery 
Configuration > 
Device Groups 

The pagination navigation controls now work correctly when 
you display the Device Type conditions for a Device Group. 

 

QC19238 Server More details about agentless scan workflow failures on 
Windows are now available in the Device Manager and the 
discovery.log file. 

QC19239 System Panel The service statistics data is now correctly displayed when the 
Daylight Savings Time change occurs. 

QC19240 HP-UX HPPA 
Agent and Scanner 

The agent and scanner no longer fail to run on HP-UX 
(HPPA) due to the unavailability of the libiconv.sl shared 
library. 

QC19241 Server Null pointer exceptions generated by the Agent 
Communicator during the agentless scanning workflow have 
been addressed. 
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Number Location Description 

QC19247 Server If the Discovery Engine fails to run a scanner on a managed 
device, it will make another attempt to re-run the scanner 
when a model update completes. 

QC19270 Server When errors are encountered during SSH agentless scanning, 
more detailed information is now reported in the log files. 

QC19271 Server The Agent Communicator no longer overwrites a legitimate 
NMID on a device that has already been scanned if the main 
IP address for the device changes. 

QC19273, 
QC19352 

Server When new devices are discovered by means of VMware 
discovery (VMware hosts and virtual machines), they will now 
be automatically triggered for SNMP modeling. 

QC19301 Server The configuration options used by the XML Enricher are now 
properly processed during an upgrade. 

QC19302 HP-UX Scanners The scanner no longer fails to run on HP-UX (HPPA) 11.00 
and 11.11 systems with the error /usr/lib/dld.sl: 
Unresolved symbol. Although this problem only occurred on 
HPPA devices, the fix is included in the scanners for both 
HPPA and Itanium platforms. 

QC19308 Device Manager When model updates for large devices took more than 9 hours, 
Device Manager reported incorrect recent device modeler 
update run times. 

QC19309 Server Safety checks have been added so that the Discovery Engine 
no longer crashes when performing specific operations as part 
of the agentless scanner deployment workflow. 

QC19311, 
QC19336 

Server When switching from agentless to agent-based scanning, the 
Discovery Engine no longer uses an un-initialized agent port 
value, which caused communication with the device to fail 
unless you restarted the Discovery Engine. 

QC19312 HP-UX (ia64) 
Scanner 

The scanner now correctly detects and reports the description 
of network interface cards that are link (port) aggregators. 

QC19313 Solaris Agent The Agent no longer fails to run on Solaris (SPARC) due to 
the unavailability of the libiconv.sl shared library 

QC19324 HP-UX (ia64) 
Scanner 

CPU speed on certain HP-UX (ia64) platforms was incorrectly 
reported.  

QC19331 HP-UX (HPPA) 
Agent 

The Agent no longer fails to run on HP-UX (hppa) 11.00 and 
11.11 systems with the error /usr/lib/dld.sl: Unresolved 
symbol. 

QC19332 Windows Agent The DDM Inventory Agent will now listen on all dynamically 
established interfaces (for example, VPN tunnels). 
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Number Location Description 

QC19340 Windows Scanner The Windows Security updates list can now be seen in the 
scan file for Windows 2008 systems. 

QC19349 Scanner The Scanner can now save the scan file based on the NMID 
asset tag – even if the NMID is only one character long. 

QC19369 Database The Aggregate.hwOSWMISoftwareFeatures table is no 
longer missing from the list of tables that is checked and 
repaired (if necessary) at start-up time. 

QC19374 Server When switching the agentless scan setting “Accept changed 
public client key” from false to true, the agent status report 
will no longer indicate a public key mismatch when the SSH 
workflow has succeeded on the node. 

QC19376 Server After the IP address of a device has changed, the server will 
automatically switch to the new IP address for subsequent 
VMware discovery attempts (provided that VMware discovery 
is configured). 

QC19391 Server The Agent Communicator no longer reuses the last good 
credentials when these credentials have been removed from 
the credentials list. 

QC19399 Server The Discovery Engine no longer crashes when it parses an 
invalid IPv4 address. 

QC19400 Applets The Network Map now displays a warning message when the 
session is in use. 

QC19403 Server If there are several versions of the Mac OS X x86 Agent and 
the Windows Agent on a DDM Inventory Server, the 
Discovery Agent no longer erroneously uses the Mac OS X x86 
Agent version instead of the Windows Agent if the Mac OS X 
x86 Agent version is more recent than the Windows version. 

QC19405 Web UI When a full-path URL is specified in the browser’s address 
box, the correct UI page is displayed (rather than defaulting 
back to the DDM Inventory main page). 

QC19406 Aggregator In some cases, data transferred from remote servers could not 
be imported into the aggregator database due to data 
conversion failures. This occurred when incoming inventory 
(WorkstationConfiguration) files from remote servers 
running a previous DDM Inventory version were converted to 
the version running on the Aggregator. 

QC19434 Aggregator The Aggregator server no longer contains left over scan file 
information for devices that do not have scan files. 
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Known Problems, Limitations, and Workarounds 

Agents 

• When you install the Agent on Windows Vista machines using an account other than the 
"Administrator" account, the firewall exception is not added into the exceptions list (QC# 382).  

• On Mac OS X 10.4.10 and above, there may be a problem with contacting the Agent because it can be 
blocked by a firewall. The Agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration (QC# 674). 

• When using the Internet Explorer and downloading an Agent from the Agents download page, the 
tar.gz files are saved incorrectly as tar.tar (QC# 18945). 

Agentless 

• In the agentless log file, the first line of the log indicates that there was error removing the 
ovedscansvc.exe file. This is just a warning message and does not mean there is necessarily an error 
(QC# 19019). 

• When using agentless scanning, once SSH credentials have been successfully used to scan a device and 
they are still configured to be used and valid, the credentials cannot be changed (QC# 19038). 

Scanners 

• Automounts are being scanned in HP-UX and Linux systems (QC# 1163).  

• In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 
options and software scanning is disabled, the Scanner will still attempt to store any previously 
configured custom stored files. (QC# 19042). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 
a File Name’’ option is selected, the “Replace invalid characters with’’ field must be populated as well, 
even if the “Delete invalid characters’’ option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QC# 1275). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QC# 1480). 

• The Analysis Workbench sample script does not run on Windows 2008 because the default directories 
are not set correctly. The script works properly on all other supported platforms. (QC #19475). 

Server Installation 

• After an uninstall, the branding registry keys are left over (QC# 1434).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(QC# 16520 and QC# 1472). 
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• When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QC# 2405). 

• DDM Inventory with a Network Topology license should not be installed on VMware (QC# 5271). 

Server 

• VMware discovery may, in some cases, use an incorrect IP address if the VMware image has been 
recently powered off. (QC# 19379) 

• In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 
results in the inability to load both files into the client tools at the same time (QC# 4448). 

• An older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 
engines (QC# 5447). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the “Listen 80’’ directive in the httpdf.conf file (QC# 6670). 

• If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 
need to restart System Monitor to recover (QC# 7409). 

Web User Interface 

• When connecting to the web UI using Firefox 3.0 with JRE 1.5 on Windows 2008 machines, Firefox may 
close when an applet is opened. (QC# 19437) 

• Credentials may disappear after navigating to the “Associated Profiles” tab and back using the Back 
button on the browser. (QC# 19417) 

• After an agentless scan using SSH has successfully been run, the account used for this connection cannot 
be changed unless you delete the account from the DDM Inventory UI. (QC# 19398) 

Administration 

• When the password of the logged in user is changed, the applets are unaware of the change and require 
restarting before they can be used (QC# 4457). 

• Depending on the licenses, the “Resource/ Environment manage’’ option in Discovery Configuration may 
not have any effect (QC# 7034). 

• In some situations, DDM Inventory will not recognize that a community string has been changed if the 
only change is to the case of a letter (QC# 18844). 

• In the Service Analyzer, device breaks may show up in the filter list for line breaks (QC# 18988). 

• In some cases, in the “Active Devices” status report, the “Modeling Status” values for scan-only devices 
may be falsely reported (QC# 19036). 

• If a VirtualCenter server does not respond to a request, DDM Inventory will not report an error (QC# 
19059). 

• In some situations, the Agent ping button in Device Manager may not ping a device. The agent ping may 
not function until the next time the scanner workflow runs. (QC# 19063). 
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Web Asset Questionnaire 

• In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 
from’’ IP address reported will be the IP address of the proxy server not that of the remote computer 
address (QC# 764). 

• The UI may show non-printable characters in text fields (QC# 2408). 

Reports 

• The + symbol in the Navigation Tree next to reports is missing. This does not affect functionality. (QC# 
18894). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (QC# 5673). 

Internationalization 

• If the name of a User zSAI file contains Chinese characters, the XML Enricher may not be able to load 
that zSAI file. (QC# 19402) 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QC# 490). 

• Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month’’ 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QC# 416). 

• There are several problems with the SAI Editor accepting characters in the Korean code page (QC# 507, 
QC# 508). 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QC# 2043). 
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